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11.0.1 Simulation Menu

All of the run-time controls are accessed through the Simulation menu located o
menu bar.  This menu contains options for running a model, specifying multiple r
cation statistics, defining scenario data, and other extended run-time options.

Access the Simulation Menu:

• Select Simulation  from the menu bar.

Each of the selections available on the Simulation menu is explained below.

Run    Choose Run to begin simulating the current model using the options previo
selected in the Simulation Options dialog box.  Choosing Run does not save the
els to the current model file.  However, the model data will be saved to the file 
autosave.mod.  To run several scenarios, you must select Run Scenarios from th
narios dialog mentioned below.  Otherwise, it will run the RTI default values.

Save & Run    Saves the current model, then runs it.

Options   Select Options to bring up the Simulation Options dialog box used to s
ify important run-time information such as run length, warm-up period, number o
replications, multiple replication statistics, and costing. (See Simulation Options on 
page 569.)

Model Parameters   Choose Model Parameters to open the Model Parameters 
log box. The dialog box allows you to modify the current settings for the RTI (Ru
Time Interface) parameters defined in the Macros module. (See Run-Time Interface 
on page 443.)

Scenarios   Select Scenarios to open the Scenarios dialog box. The dialog box 
allows you to define different scenarios using defined RTI (Run-Time Interface) 
parameters. (See Scenarios on page 576.)

a How To
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11.1 Simulation Options
The Simulations Options dialog provides you with a number of options to control
simulation, such as run length, warm-up time, clock precision, and the output. Yo
also control the type of statistics reporting you want from the simulation which 
includes period length and number of replications. 

In addition to reporting standard statistics based on one or more replications of a
ulation, ProModel now allows you to average statistics across intervals of a singl
replication (batch mean) for analyzing steady-state systems or take the average 
average statistics for specific time periods over multiple replications (periodic) fo
non-steady-state systems. You may choose from three statistical reporting optio

Replication statistics no longer need to be defined before running a model. All st
tics are collected during multiple replication runs.

Open the Simulation Options dialog:

1. Select the Simulation  option from the menu bar.

2. Select Options  to open the Simulation Options dialog.

G Note

a How To
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11.1.1 General Options & Settings

Output Path   Contains the path of the output file (the name of the file is automa
cally created using the name of the model).  ProModel records all statistical outp
this file for your analysis.  When you change the default path, be sure the path y
enter actually exists, or an error will occur at run time.

Define Run Length by  ProModel allows you to define a run length for you mode
based on the duration you will test.

• Time Only  The total run length in hours.

• Weekly Time   The total run length by week, day, and time.

• Calendar Date   The total run length by a specific calendar date and time.

• Warm-up Period   The amount of time to run the simulation before collect
ing statistics. Usually this is the amount of time it takes for the model to re
steady state. The warm-up period uses the same units as the run length.
570 ProModel User’s Guide 
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Clock Precision    Select the clock precision value from the drop down box. The
click the radio button for the clock units you want to display at run time.

The maximum run length depends on the clock precision and time unit selected.
following table shows the maximum run hours for each precision setting.

The following table shows the default precision selections based on the time uni
selected in the General Information dialog.

Disable Time Series   Use this option to improve run-time speed by foregoing tim
series statistics. This also saves disk space used to store the collected statistics

Disable Animation   Use this option to improve run-time speed by shutting dow
the animation.

Disable Cost   When you select this option, ProModel disables all cost informati
collection for in the model.

Pause at Start   To pause the simulation at the start of the run, use this option.  
simulation will pause until you select Resume from the Simulation menu in the S
lation module.

Display Notes   Use this option to display the notes from the General Informatio
dialog at the beginning of the simulation.

TIME UNIT

CLOCK PRECISION

.01 .001 .0001 .00001

Seconds (sec) 11,930 hrs 1,193 hrs 119 hrs 11 hrs

Minutes (min) 715,827 hrs 71,582 hrs 7,158 hrs 715 hrs

Hours (hr) 42,949,672 hrs 4,294,967 hrs 429,496 hrs 42,949 hrs

TIME UNIT

DEFAULT CLOCK PRECISION SELECTIONS

Clock Unit Clock Precision Maximum Run

Seconds (sec) Seconds .01 11,930 hrs

Minutes (min) Minutes .001 71,582 hrs

Hours (hr) Hours .001 4,294,967 hrs

Days Hours .001 4,294,967 hrs

G Note
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11.1.2 Output Reporting Options

Standard   When you select Standard output reporting, ProModel collects outpu
statistics for one or more replications. No interval length can be specified when u
this option. From the output program, statistics can be viewed for each replicatio
although, by default they are displayed as an average over all the replications.

Batch Mean    The method of batch means, or interval batching, is a way to colle
independent samples when simulating steady-state systems as an alternative to
ning multiple replications. The advantage over running multiple replications is th
the warm-up period runs only once. When you select Batch Mean output reportin
the output statistics are collected for each time interval indicated in the Interval 
Length field. The number of intervals is determined by dividing the run length by
interval length. The interval length may be an expression but will only be evaluat
once at model translation, so it is always a fixed interval. The Number of Replicat
edit field is not used when this option is selected since it replaces the need for ru
multiple replications.

The Content History graph below shows that the contents of Lathe1 varied throug
the simulation. The interval length was set to 0.5 hours and the simulation ran a 
over 3 intervals (1 1/2 hours). The average or mean of the intervals were 2.7, 3.09
3.15, so the average of the interval averages is the batch mean or 2.98.

�Example
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Periodic    Useful primarily in terminating or non-steady state simulations where y
are interested in the system behavior during different periods (e.g., peak or lull p
ods) of activity. 

When you select Periodic output reporting, the output statistics are collected by 
period where the length of a period is defined in the interval length field.

The interval length may be an expression but will only be evaluated once at mod
translation, so it is always a fixed interval. To define unequal intervals, see Custo
ized Reporting which follows.

You may gather statistics for a periodic report over multiple replications. From th
output program, you can view each replication averaged over the periods, each p
averaged over the replications, or the pooled average (the average for each peri
averaged over all of the replications).

The content history table below shows how the contents of Lathe1 varied throug
the simulation and from one replication to the other.  The interval length was set t
hours and the simulation ran a little over 3 periods (11/2 hours) with two replicatio
The results are shown below.

Interval Length    Enter the interval length as the number of time units for each 
interval or period. The interval length may be an expression but will only be evalu
once at model translation, so it is always a fixed interval. To define unequal inter
see Customized Reporting which follows. The time unit is defined in the Genera
Information dialog. The interval length need only be specified when using Batch 
Mean or Periodic reporting.

Number of Replications   Enter the number of replications you want the simula
tion to run in this field.  Number of replications only needs to be specified when u
Standard or Periodic reporting.

Periodic Output Period 1 Period 2 Period 3

Replication 1 Avg. 2.70 3.09 3.15

Replication 2 Avg. 2.20 3.13 3.01

Pooled Average 2.45 3.11 3.08

�Example
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11.1.3 Running a Specific Replication

ProModel allows you to run a specific replication in order to produce time series 
graphs in the Output Program. To run a specific replication, enter the “@” symbo
the “Number of Replications” box followed by the replication number. For examp
“@5” will run only the fifth replication.

11.1.4 Customized Reporting

For customized reporting, you may want to take advantage of the following state
ments: REPORT, RESET STATS, and WARMUP. See Report on page 211, Reset 
Stats on page 215, and Warmup on page 250 of the ProModel Reference Guide for 
syntax and examples.

REPORT   A general statement called from any logic. When the statement is ca
a full set of statistics is saved to be viewed as a snapshot report in the output pro
sor.  Optionally, the statement optionally allows you to reset the statistics after th
report is saved, giving you a batch or period for any time interval you define.

RESET STATS   A general statement called from any logic and is generally used
connection with the REPORT statement. When this statement is used, all statistic
set to zero.  The output database is not erased (see WARMUP).

WARMUP   A general statement called from any logic. When this statement is u
all statistics are set to zero and the output database is erased.  Use this stateme
conjunction with the WAIT UNTIL statement to wait until specific parameters in th
system being modeled are at a steady state or other conditions are appropriate 
declare the warm-up period over.
574 ProModel User’s Guide 
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11.2 Model Parameters & Scenarios

11.2.1 Model Parameters

The Model Parameters dialog box allows you to modify the current settings for th
Run-Time Interface (RTI) parameters defined in the macros module.  This provid
convenient interface for making model changes without using the Build modules
define and run multiple scenarios using RTI parameters, select the Scenarios op
from the Simulation menu (see discussion on Scenarios later in this section).  M
parameter settings are saved with the model for future use.  

Parameter    The name of the macro defined in the model as the RTI (Run-Time 
Interface) parameter.  The parameter name does not need to be the same name
macro.

Current Setting    The current setting of the parameter.

Change   Allows you to change the current setting of the parameter.

Reset All   Resets all parameters to the default RTI setting defined in the Macro
module.

Run    Runs the model with the defined current model parameter settings.

Define an RTI parameter:

1. Choose More Elements  from the Build  menu.

2. Choose Macros .

3. Type the macro name, choose the RTI button, and select Define.

a How To
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4. Define the Parameter Name.

5. Enter the Prompt (optional).

6. Select the parameter type, Unrestricted Text or Numeric Range.

7. If defining a Numeric Range, enter the lower and upper boundary for the 
range.

8. Click OK.

9. Use the macro ID in the model (e.g., operation time, resource usage time, 
etc.).

For more information on RTI, see Run-Time Interface on page 443. 

11.2.2 Scenarios

ProModel gives you the option of defining several scenarios for a model using R
parameters specified for the model.  A scenario is a set of run-time parameters w
settings defined by the user.  Using scenarios allows you to alter various model 
parameters to run a series of “what-if” scenarios without changing the model dire
This technique makes it easy for people who have no interest in dealing with the 
eling logic to efficiently make changes to the model and learn what would happe
under a variety of circumstances.  Scenarios are saved with the model for future

Add    Opens the Scenario Parameters dialog box to add a scenario.

Edit   Opens the Scenario Parameters dialog box to edit an existing scenario.

G Note
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Duplicate   Duplicates the selected scenario and opens the Scenario Paramete
log box, allowing you to give the newly created scenario a name and edit its data

Delete   Deletes the selected scenario.

Disable/Enable   Disables or enables the selected scenario.

Run Scenarios    Runs the model with the defined scenarios.  When running sev
scenarios, clicking on the Abort button during translation will terminate all scena
instead of just the current scenario.

Scenario Parameters Dialog

The Scenario Parameters dialog box is displayed when choosing Add, Edit, or D
cate from the Scenarios dialog box.  This allows you to control the specifics of a
scenario.

Scenario Name   The name of the scenario.  This name is chosen by the user a
may contain any alphanumeric characters.

Parameter   The name of the parameter as defined in the RTI (Run-Time Interfa
definition dialog box invoked from the Macro editor.

Current Setting   The current setting of the parameter.

Change    Allows you to change the current setting of the parameter.

Reset All    Resets all parameters to their default settings.

Only macros defined as RTI parameters will be displayed as parameters for the 
nario. (See Macros on page 439.)

� Note
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1. Choose Scenarios...  from the Simulation  menu.

2. Choose the Add  button.

3. Define the scenario name by typing text in the Scenario Name box.

4. Double-click on the Parameter to bring up the parameter dialog box or 
select the Parameter and click the Change  button.

5. Type the text in the box in the Parameter dialog box.

6. Select OK in the Parameter dialog box.

7. Repeat for every parameter desired.

8. Select OK in the Scenario Parameters dialog box.

� How To
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11.3 Running the Simulation
Choosing Run begins the simulation of the current model.  The model is automa
cally saved in a file called autosave.mod.  Therefore, if the simulation is terminat
abnormally for some reason, ProModel will ask you if you would like to load the 
est autosave.mod file when you re-open ProModel.  If you choose Save & Run t
model will be saved in the AUTOSAVE.MOD file as well as the <model name>.m
file.

Once you choose the Run option, a translation status window appears, showing w
data is currently being translated.  This gives you the option to abort the simulati
run at any time.  As shown below, the path networks are being mapped.

Abort    Allows you to cancel model translation at any time during translation.

Continue    Allows you to continue model translation when a warning message is
displayed.

Detailed Status   Allows you to view more specific information about the data in
translation.
ProModel User’s Guide 579
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11.4 Run-Time Menus & Controls
Once a simulation begins, a new menu bar appears at the top of the screen with
tions for controlling and interacting with the simulation.  As shown below, these m
items appear above the animation speed control bar and simulation clock.

Each of the menu selections and the tools for controlling the animation are desc
in the remainder of this chapter.
ProModel User’s Guide 581
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11.4.1 Run-Time File Menu

The run-time File menu contains only one selection: View Text. 

View Text   Choose this option to bring up a window with a text listing of the curre
model. This feature is extremely useful for debugging and verifying models.

You may switch back and forth between a full size View Text window and the ani
tion screen by choosing the desired window from the Window menu option.

11.4.2 Run-Time Simulation Menu

The Run-Time Simulation menu has two options: End Simulation and Pause/Res
Simulation.

End Simulation   Choose this option to end the simulation.  You will then be 
prompted to collect statistics or return to the model editor without collecting statist
If running multiple scenarios, End Simulation will terminate all scenarios.

Pause/Resume Simulation   Choose Pause Simulation to pause the simulation 
an indefinite amount of time. With the simulation paused, you may begin a trace
zoom in or out, set up the next pause, examine different locations in the model, o
interact with the model in a number of other ways. Choose Resume Simulation w
the simulation is paused to continue running the simulation.

� Note
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11.4.3 Run-Time Options Menu

The Run-Time Options menu has several selections that allow you to interact wit
simulation while the model is running.  These options are described in the follow
pages.

Debug    Brings up the Debugger Options Dialog box for debugging the model.  

Trace   Lists events as they happen during a simulation.  This listing may be Ste
Step or Continuous.

Trace Output   Gives the user the option to send the trace to a file (<model 
name>.TRC) or to the window.

Animation Off/On   Turns the animation on or off. Off greatly speeds up the simu
tion. Animation speed may also be set with the ANIMATE statement. (See Animate 
on page 117 of the ProModel Reference Guide for information.)

Zoom   Zooms in or out on the animation.

Views  Allows you to select a view defined while building the model.

User Pause    Allows the user to enter a simulation clock time for the simulation 
pause.
ProModel User’s Guide 583
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11.4.4 Debug Option

Debugging ProModel Logic

The Debugger is a convenient and efficient way to test or follow the processing o
logic defined in your model.  The debugger is used to step through logic one sta
ment at a time and examine variables and attributes while a model is running.  

Before discussing the details of the Debug option, it is important to understand t
following terms:

Statement    A statement causes ProModel to take some action or perform some
operation. This includes statements such as GET, JOIN, etc. (See Get on page 155 and 
Join on page 172 of the ProModel Reference Guide for more information.)

Logic   A logic is the complete set of statements defined for a particular process
record, downtime event, initialization or termination of the simulation, etc.

Thread   A thread is a specific execution of any logic.  A thread is initiated whene
a logic needs to be executed.  This can be an entity running through an operatio
logic, the initialization logic, a resource running a node logic, a downtime logic, o
any other logic.  Note that the same logic may be running in several threads at th
same time.  For example, three entities of the same type being processed simul
neously at the same multi-capacity location would constitute three threads.

A thread or logic execution can be suspended by any statement, causing simula
time to pass (e.g., GET Res1, WAIT 5, etc.) After such a statement completes its
the thread is resumed. During the time a thread is suspended, other threads ma
initiated, suspended, resumed, or completed. This is called thread switching.

Even though there can be several threads executing the same logic at the same 
time in the simulation, the simulation processor can only process them one at a 
So there is really only one current thread while all other threads are suspended (
scheduled for some future simulation time, or waiting to be executed after the cu
thread at the same simulation instant).

� Note
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Example

To better explain the above concepts, consider the following operation logic for a
multi-capacity location.  

The logic includes all statements shown on previous page. Let’s assume that the
three different entities currently executing this operation logic. Each executing en
constitutes a thread. A possible scenario for this case is the following: Thread 1 
entity using two units of resource Oper_3 for N(35,5) minutes. Thread 2 is an en
waiting for resource Oper_1 to become available. The last thread is a different e
which has completed 10 minutes of the 15 minute wait executed at the beginning
the logic. Note that two entities arriving at a multi-capacity location at nearly the 
same time could both execute the same WAIT or USE time in the logic, only in di
ent threads.

In general, for a logic block containing statements that pass simulation time, any
number of threads can wait for the required simulation time to elapse, correspon
to each time elapsing statement. These threads are scheduled to resume at som
simulation time.

There can also be many threads (any number of threads corresponding to each 
time elapsing statements within the logic) which have completed their waiting tim
but await their turn to continue execution. These threads are on hold because th
ulation engine is busy with another thread scheduled for the same simulation tim
instant.  There is only one thread executed at any real time instant by the simula
engine.

The debugger window will display a unique identification number for the current,
active thread.  This thread ID number will help you differentiate between differen
instances of the same logic block while you are debugging your models.

Logic 

Line of execution 
for Thread 3

Line of execution 
for Thread 2 

Line of execution 
for Thread 1 
ProModel User’s Guide 585
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Debugger Options Dialog Box

The Debugger Options dialog box allows the user to specify when to display the
Debugger dialog box during the simulation run.  

Disable debugger    Disables the debugger completely.  By default, the debugge
enabled.  Running the model with the debugger disabled increases the run spee
When running multiple replications or scenarios, or when the animation is disabl
the debugger will automatically be disabled.

DEBUG statement    Displays the Debugger dialog box every time a DEBUG sta
ment is encountered in an enabled process while running the simulation. See DE
statement in the ProModel Reference Guide for more information.

Global Change    Displays the Debugger dialog box every time a global change 
occurs to a specified variable, attribute (entity or location), or array.  The Debugg
dialog box shows the original and new value of the element.  Only one global na
can be specified in this box.  

User Condition   Displays the Debugger dialog box when a defined user condit
written as a Boolean expression becomes true, for example, when Var1=5. Only
expression can be specified in this box, although several conditions can be teste
using the OR operator. See the Boolean Expressions on page 71 of the ProModel Ref-
erence Guide for more information.

Check Condition   Allows the user to define how often to check the user conditio
The options include:

• Before each statement   The condition, such as Var1=1, will be checked 
before each statement is executed.  This option is the most precise way to
586 ProModel User’s Guide 
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exactly when the user condition becomes true, but slows down the simula
the most.  

• At each thread switch   The condition, such as Var3>17, will be checked 
only if a statement from a different thread follows the current statement be
executed.  

• At each thread initiation   The condition, such as Att1=5, will be checked
only if the next statement to be executed is the first statement in a thread (
first statement in a thread is also the first statement of a logic).  

Debug button    Pressing the Debug button displays the Debugger dialog box be
the next statement executes.

OK   Closes the Debugger Options dialog box and continues to run the simulatio
model.

Debugger Dialog Box

The Debugger can be used in two modes:  Basic and Advanced.  The Basic Deb
appears initially with the option of using the Advanced Debugger.  The Basic De
ger dialog box is shown below:

Error Display Box    Displays the error message or reason why the Debugger dia
box is displayed, such as the User-Condition becoming true.

Logic Display Box    Displays the statements of the current logic being executed

Error Dialog Box 

Information Box Logic Display Box 
ProModel User’s Guide 587
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Information Box    Displays either the context of the logic or local information as
mentioned below.

Context    Displays the module, operation, and line number (in which the debugg
stopped) in the Information box.

Local Information    Displays local variables and entity attributes with non-zero v
ues in the Information box.

End Simulation    Choose this option to terminate the simulation.  This will prom
you about collecting statistics.

Run    Continues to run the simulation, but still checks the debugger options sele
in the Debugger Options dialog box.

Next Statement    Jumps to the next statement in the current thread. If the last s
ment executed suspends the thread (e.g., the entity is waiting to capture a resou
another thread meeting the debugger conditions may be displayed as the next 
statement.

Next Thread    Brings up the Debugger at the next initiated or resumed thread.

Into Subroutine   Steps to the first statement in the next subroutine executed by
thread.  Again, if the last statement executed suspends the thread, another threa
meeting debugger conditions may be displayed first.  If no subroutine is found in
current thread, a message is displayed in the Error Display box.

Options   Brings up the Debugger Options dialog box.  You may also bring up th
dialog box from the Simulation menu.

Advanced   Changes the Debugger to Advanced mode, providing additional opti
discussed next.
588 ProModel User’s Guide 
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Advanced Debugger Dialog Box

The Advanced Debugger contains all options in the Basic Debugger plus a few 
advanced features.

Next (Thread)   Jumps to the next initiated or resumed thread.  This button has 
same functionality as the Next Thread button in the Basic debugger.

New (Thread)   Jumps to the next initiated thread.

Disable (Thread)    Temporarily disables the debugger for the current thread (se
also enable).

Exclusive (Thread)    The debugger displays the statements executed within the
rent thread only.  When the thread terminates, the exclusive setting is removed.

Next (Logic)   Jumps to the next initiated or resumed thread not executing the s
logic as the current thread.

New (Logic)    Jumps over any resumed threads to the next initiated thread not e
cuting the same logic as the current thread. 

Disable (Logic)    Temporarily disables the debugger for all threads executing th
current logic (see also enable).

Exclusive (Logic)   The debugger displays only the statements executed in any
thread executing the current logic.

Enable disabled threads and logics    Enables the threads and logics which we
disabled previously.
ProModel User’s Guide 589
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Debugger Options Examples

Debug Statement Example

A simulation model demonstrates a proposed flexible manufacturing system whi
produces castings. A variable, WIP, is used to track the work in process for the s
tem. Suppose we want to display the Debugger when the variable, WIP, reaches
value of 300. We could place an IF...THEN statement including DEBUG after the
statement incrementing the variable, WIP, as shown below: 

By checking the box next to the DEBUG statement in the Debugger Options dial
the Debugger is displayed when the variable, WIP, reaches 300.

Global Change Example

Suppose we want to know when the variable, COUNT, is incremented.  We woul
check the box to the left of Global Change and type COUNT in the Global Chan
field.  This will display the Debugger dialog box each time COUNT changes.  It w
also display the previous and changed value of COUNT. 
590 ProModel User’s Guide 



 Section 11.4  Run-Time Menus & Controls

11
.4

.4

n 
ique 

ion 
itia-
 
ing 
User Condition Example

Suppose we want to follow a casting through the entire system (i.e., from when a
entity enters the system to when it exits). We would set an attribute equal to a un
number in the arrival logic for a single casting (Att1=3). In other words, only one 
casting in the system should have Att1=3. We would then check the User Condit
box and enter the condition as “Att1=3.” We would then select At Each Thread In
tion as the Check Condition. The debugger is displayed each time that particular
casting initiates a new thread. For example, the debugger may display the follow
information:

Casting @ Loc1: GET Oper_1
WAIT N(5,3)
INC Var1
FREE Oper_2

Casting @ Loc2: JOIN 1 Fixture
...
...
...
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Debugger Dialog Examples

Suppose we have the following logics in the processing table of the model.  Both
ics are found at multi-capacity locations.  Let’s assume two castings are being 
processed at Load_Station while three castings are being processed at Unload_S
at this instant of simulation time.

Logic for 
Load_Station 

Logic for 
Unload_Station 
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Next Statement

If we accessed the Debugger dialog box and the next statement executed was J
Casting in the logic for Load_Station, we would see the following dialog box:

If we continued to click on the Next Statement button, it would lead us through th
logic statement by statement. Since the JOIN statement may cause some simula
time to elapse, the next statement displayed may be a statement within another 
if that thread matches the requirements of the debugger (e.g., a variable changed
condition met, etc.) unless: 

1. There is already a part waiting for a JOIN request and there are no othe
threads scheduled for the same simulation instant, or  

2. There are no other threads scheduled over the simulation time until afte
requested part becomes available

The unique thread ID shown in the middle-right portion of the debugger window 
indicate whether we have switched threads or not.

If you are using the Next Statement button in multiple threads simultaneously, al
threads will be shown in the order in which the statements are executed in simul
time.

� Note
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Next Thread

If we clicked on the Next Thread button, it would automatically switch us to the n
thread executed during the simulation run. The next thread may or may not be u
the same logic. For example, suppose the Debugger dialog box shows that we a
the logic for Unload_Station at “Use 2 Oper_2 for N(5,2).” Selecting the Next Thr
button may show us another entity at Unload_Station while executing a different
statement within the same logic such as “Get Oper_2.” This is the next thread be
it refers to a different entity, although the entities may have the same name. In fa
two entities could execute the very same line of logic using different threads.

New Thread

Consider a situation where you are using the debugger and have concluded that 
current threads are executing properly.  You want to go to a new thread which ha
yet been initiated.  For example, you may have six entities, three EntA’s and thre
EntB’s, in a system which are executing logic as intended.  Choosing New Threa
may display the information for an entity, EntC, which has just arrived into the sys
and is creating a new thread. It may also display information about other EntA’s 
EntB’s which may arrive at any location or thread related to resource downtimes
node entry/exit logics.

Next Logic

When a logic is functioning well in all its various threads and you are not intereste
examining that logic any more, choosing the Next Logic option will hide the Debu
ger until ProModel switches to a thread of a different, possibly already running lo
For example, you may be currently viewing the logic for Load_Station but wish to
look at a logic elsewhere in the model, possibly at Unload_Station.  Selecting the
Next Logic button would jump to the next thread (resumed or initiated) not execu
the current logic.

New Logic

New Logic will jump to a newly initiated thread that will not execute the current 
logic.  If there are two entities at Load_Station and, while executing the logic at 
Load_Station you choose new logic, you will jump to the logic at a location in wh
the logic is not currently executing. 
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Exclusive Thread

To debug the model and ensure castings are traveling through the system as pla
we can follow a single thread completely through the logic.  To do this, check the
Exclusive box next to Thread.  This option will follow the current thread through t
end of the logic.  There may be 50 entities in the system at a particular time, but
choosing the Exclusive box will follow only one of the 50 entities. That is, the thre
ID number displayed in the debugger window will stay the same until the current
thread is disposed.

Exclusive Logic

To ensure a particular logic is executing as planned, use exclusive logic to check
behavior of several entities for a specific operation logic or several units of resou
for a specific resource downtime logic.  For example, there may be three entities
cuting the logic at the Unload_Station location.  Selecting exclusive logic will sho
the three different threads executed for the three entities at the location because
threads are separate instances of the same logic.

This may be particularly useful for long logics with several IF...THEN statements
based on attribute values. Suppose a logic contains ten IF...THEN statements ba
attribute values, Att1=1, 2, 3,...10. Depending on the attribute value, a different p
cessing time is executed with different resources. If you want to follow the logic a
this location to ensure it is executing properly, use exclusive logic.

11.4.5 Trace Options

A trace is a list of events occurring over the course of a simulation.   For example
trace statement might state “EntA arrives at Loc1, Downtime for Res1 begins.” A
trace listing also displays assignments, such as variable and array element assig
ments. A trace listing of a simulation run may be viewed in several ways through
trace options provided.

Trace Mode

A trace listing is generated in one of two modes, Step or Continuous.

Off   Select this option to discontinue a current trace.

Step   Select this option to step through the trace listing one event at a time.  Ea
time you click the left mouse button, the trace will advance one event.  Clicking a
holding the right mouse button while in this mode generates a continuous trace.

Continuous   Select this option to write the trace continuously to the output dev
selected from the Trace Output submenu.  This is useful when you do not know 
exactly where to begin or end the trace.  Clicking and holding the right mouse bu
stops the trace until you release the button.
ProModel User’s Guide 595



Chapter 11  Running the Model
11

.4
.6

tput. 

You 

s are 

l the 

nges 
 
e run 
ions 

is 
oose 
 the 

de the 
he 

 

Trace Output

A trace may be sent to one or more output devices by checking each desired ou
For example, you may select “To Window” and “To File” to see a listing on your 
screen and also save the information in a text file.

To Window   Select this option to view the trace in an on-screen trace window.  
may size the trace window to your liking to see more or less of the trace listing.

To File    Select this option to send the trace listing to a text file. Trace statement
automatically written to a <model name>.TRC file.

11.4.6 Animation Options

In addition to the debug and trace options, animation options allow you to contro
animation screen.

Animation Off   Choose this option to temporarily suspend the animation. To 
resume the animation, select this option again. (The selection automatically cha
to “Animation On.”) Note that running with animation off greatly increases the run
speed, especially for models with a large amount of graphic detail. To increase th
speed to an even faster rate, check the Disable Animation in the Simulation Opt
before running the model (see Simulation Options on page 569).

Zoom   Select this option to Zoom in or out on the animation.  When this option 
selected, you may choose a preset zoom level, enter your own zoom level, or ch
Zoom Full to fit the entire animation on one screen.  The Zoom function zooms to
center of the screen.  If the zoom factor causes the model layout to appear outsi
layout window, the zoom function will automatically pan to show at least part of t
layout.

Views   Click on this menu item to display the available views.  Select the desired
view.
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User Pause   Choose this option to enter a time for the simulation to pause.  Th
proper format for specifying a user pause is hh:mm.xx where hh represents hours
represents minutes, and xx represents hundredths of a minute.

11.4.7 Run-Time Information Menu

The Run-Time Information menu allows you to see the status of locations in two
ferent ways.  In addition, you may view the current state of all variables and arra
elements.  Each of these options is defined in the following pages.

Status Light   Select this option to bring up the Status Light Legend shown on t
following page. 

Locations   Select this option and choose a location to view an information box w
real time information about the location.  Information for all locations may also b
displayed.

Variables   Select this option to show the current state of all real and integer glo
variables.

Arrays   Select this option to show the current value of all cells for arrays of up t
three dimensions.

Dynamic Plots   Allows you to graphically monitor the performance of model ele
ments during run time and store statistical data in an Excel® spreadsheet. 
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Location Status Legend

The Location Status Legend shows the different colors of a location status light a
the meaning of each color.  Single capacity locations may be in any of several st
while multi-capacity locations appear only as up or down.  This window may rem
open during the simulation.
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11.4.8 Dynamic Plots

The dynamic plot enables you to graphically observe and record statistical inform
tion about the performance of model elements during run time.
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Getting to Know the Dynamic Plots Dialog

Windows and controls

The dynamic plot dialog contains a factors list, four panels, and several button c
trols. The factors list contains each of the available model factors from your mod
and the panels display performance graphs for the factors you select. You can u
main panel to display a single factor’s performance graph or combine the graphs
the factors displayed in panels 1, 2, and 3.

Panel 3

Panel 2Panel 1

Main panel 

Factors list

Most recently 

Quantity

Time Units
selected factor
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Right-click menus

Right-click menus for dynamic plots are available for panels 1, 2, 3, and the main
panel. When you right click in any of these panels, one of the following menus 
appears.

Panels 1, 2, and 3

Move Up   Places the graph in the main panel.

Clear Data   Removes the factor and its graph from panel 1, 2, or 3, and the main 
panel. If you created a multi-line graph, Clear Data removes the selected item fr
the graph and does not disturb the remaining graph lines.

Line Color   Allows you to assign a specific line color to the graph.

Background Color   Allows you to define a specific background color for panels 
1, 2, and 3.

Save

Snapshot

Grid

Multi-line

Refresh

Saves a copy of ALL model data—from the time you start the dynamic plot to 
when you click save—to an Excel® spreadsheet. See Saved Files on page 607.

Saves a copy of currently displayed, graphed model data to an Excel® spread-
sheet. See Snapshot Files on page 607.

Turns the main panel grid lines on and off.

Displays a combined graph of panels 1, 2, and 3.

Redraws the graphs.
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Clear All Data   Removes all factors and graphs from panels 1, 2, 3, and the main 
panel. 

Remove Line 1, 2, 3   Deletes a specific line from the main panel.

Background Color   Allows you to define a specific background color for panels 
1, 2, and 3.

Grid Color   Allows you to assign a specific line color to the grid.
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Create a dynamic plot:

1. Open and simulate the model you wish to examine.

2. Select Dynamic Plots  from the run-time Information  menu. The dynamic 
plots dialog will appear. 

To allow you additional time to set up the dynamic plot, pause the simulation.

3. Select the model factors you wish to graph from the factors list. To create 
a plot for a specific item, select the item and right click. 

� How To

� Hint
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4. From the pop-up dialog that appears, select the panel to which you will 
display the graph for the item. (Repeat steps 3 and 4 to display graphs in 
other panels.) 

If you double click on an item in the factors list, the factor will display in 
Panel 1.

5. Once you identify the factors you wish to observe, graphs for these factors 
will appear in the panels you assign. 

�Note
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Graph a single factor to the main panel:

• Right click in panel 1, 2, or 3 and select Move Up (or double click). The 
graph for the item will appear in the main graph panel. 

� How To
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Graph multiple factors to the main panel:

• After you define the factors for panels 1, 2, and 3, click the multi-line 
button. 

� How To
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Output Results

ProModel places spreadsheets recorded from your model into the same location
your original model file.

Saved Files

If you record model data files using the save command, ProModel saves a copy 
ALL model data—from the time you start the dynamic plot to when you click sav
to an Excel® spreadsheet. To help you identify this file, ProModel uses the model 
name followed by DP (for Dynamic Plots) and an XLS (for Excel®) extension. For 
example, the spreadsheet for “My_Model.mod” is:

My_ModelDP.XLS

If you save multiple files, you have the option to save each file under a different n

Snapshot Files

When you record statistics using the snapshot command, ProModel creates an E® 
spreadsheet using the model filename followed by SNP (for Snapshot) and an X
(for Excel®) extension. For example, the spreadsheet for “My_Model.mod” is:

My_ModelSNP.XLS

If you take multiple snapshots during the simulation, ProModel appends the info
tion to the file (i.e., sheet 2, sheet 3, sheet 4). 

When you run the simulation again and create a new spreadsheet, ProModel ch
the old spreadsheet to a backup file and creates a new SNP.XLS file. Since ProM
retains only two snapshot files (XLS and BAK), new files replace old files.

My_ModelSNP.BAK(the old SNP.XLS file)
My_ModelSNP.XLS(the new SNP.XLS file)

�Note
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Location Information Windows

A Location Information Window gives real-time information regarding the status o
location including the current contents, operational state, total entries, and entity
types.  This window may remain open during the simulation.

You may also view information for all locations at the same time.  To view inform
tion for all locations, select All Locations at the Locations submenu.

If the location’s statistics field is set to none, the number of entries will not be ava
able, so the entries field will show N/A.

� Note
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Variables Display Option

The variables display option allows you to view the current state of all global vari
ables at any point in the simulation.  You also have the option to evaluate an 
expression and see the result using the current variable values.

In this example, the expression (sum of two variables, WIP and THROUGHPUT)
be computed by clicking the Result button.  A listing of the variables and their cur
values may be printed by clicking the Print button.  The value of a variable may b
changed at any time during the simulation by clicking the on the Change button 
entering the desired variable value.
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Array Display Option

The Arrays display option allows you to view the current value of the cells for an
array of up to three dimensions at any point in the simulation.  To view the eleme
of an array simply select Arrays from the Run-Time Options menu.  This brings u
array selection box like the one shown on the next page.  Double-click on the ar
you wish to view or press the View button.

The example below is for a two-dimensional array that keeps track of the numbe
entities of type 1 and type 2 that have been processed at each of six locations.  T
rows represent the six locations and the two columns represent the two entity ty
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11.4.9 Run-Time Window Menu

The Run-Time Window menu allows you to rearrange windows and icons and se
the active window.  These functions are standard to all Windows applications.

Tile    Causes all open windows to fit in the available screen space.  Windows hid
behind other windows become visible.

Cascade    Causes all open windows to overlap such that the title bar of each win
is visible.

Arrange Icons    Causes all icons representing iconized applications or windows
be arranged neatly along the bottom of the screen.
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11.4.10 Run-Time Interact Menu

The Run-Time Interact menu displays the Interact dialog box. It allows you to exe
interactive subroutines during run-time. Interactive subroutines are defined in the
Subroutines edit table (see Subroutines Edit Table on page 451).

Execute an interactive subroutine during run-time:

1. Select Intera ct  from the run-time menu.

2. Select the identifier for the subroutine from the list box in the Interact dia-
log box.

3. Choose the Activate  button.

� How To
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11.4.11 Run-Time Help Menu

The Run-Time Help menu contains selections for accessing the ProModel on-lin
help system.  It operates the same here as in the model editing functions.

Index...    Choose this option to bring up the Main Help Index.

Context   Choose this option to go directly to the help screen that corresponds to
active window.  If no context sensitive help exists for the active window, the Main
Help Index will appear.

About...   Choose the option to display a message containing software version 
information.
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11.4.12 Run-Time Controls

In addition to the animation options discussed in the previous section, you may p
the animation screen in any direction, control the speed of the simulation, and ch
the format of the simulation clock display.  These and other procedures are discu
in this section.

Pan through the animation:

1. Press and hold the left mouse button anywhere on the animation screen.  
This point then becomes the “anchor point” by which the entire animation 
is moved.

2. Drag and release the mouse where you desire the anchor point to be 
located.  The following diagram illustrates this procedure.

� How To

Desired Location

Anchor
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Control the simulation speed:

• Move the animation speed control bar to the left to decrease the simula-
tion speed or to the right to increase the simulation speed.

The speed of the animation may be altered by model logic with the use of the AN
MATE statement. (See Animate on page 117 of the ProModel Reference Guide.)

� How To

Slower                               Faster

� Note
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Change the format of the simulation clock display:

1. Click on the simulation clock button.

2. Select a format for the clock display.

Identify any location on the layout:

• Click on a location while holding the CTRL key.  (An identifier box 
appears, allowing you to bring up the location information window for that 
location.)

� How To

� How To
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